
 



 VERSION 2.0 UPDATE    VERSION 2.0 UPDATE    VERSION 2.0 UPDATE    

CHAMP has been updated to version 2.0, to include the following:  

• Capability to model the 0.2% annual chance event (500-year) has been added 
to CHAMP.  New inputs for the 500-year event include wave height, wave 
period, and wave setup.  Erosion for the 500-year event is based on a dune 
reservoir of 1,030 square feet. 

• Added a user option under the Transect menu to round all station numbers to 
the whole foot.  Once this function is executed the decimal numbers can not 
be recovered.  Also all tables will now display the entire station number 
without rounding.  This is useful when detailed topographic data such as 
LIDAR data is used to extract ground profiles and may have numbers out to 
multiple decimal places.  For long transects this may present a problem 
because the WHAFIS program only allows for 6 spaces for the station number 
including the decimal point.  Any station number greater than 9999 does not 
allow the use of any decimal places. 

• The option to input different wind speeds for the OF, IF, and VH cards other 
than the default has been added to CHAMP under the General parameters tab.  
If these fields are left blank the defaults are used.  For the 100-year winds the 
defaults are: OF=80mph; IF=60mph; VH=60mph.  For the 500-year winds the 
defaults are: OF=100mph; IF=75mph; VH=75mph. 

• Corrected the calculation of the dune eroded volume when a dune retreat case 
is encountered.  (Previous versions incorrectly calculate the dune reservoir 
area.)  Also fields were added to the Erosion program to show the value of the 
total eroded area and the eroded area above the stillwater. 

• An error message will now display when the eroded profile slope does not 
intersect the ground profile. 

• CHAMP will now automatically insert points in the profile where the total 
stillwater intersects the ground profile when the WHAFIS table is populated.  
Note that the inserted points are only made based on the starting total 
stillwater elevation input into the General Parameters tab.  If a change of total 
stillwater is made along the profile such as a reduction to a backbay stillwater 
or reduction of wave setup new ground intersection points will need to be 
inserted. 

• CHAMP will now remove duplicate station points when the WHAFIS table is 
populated.  Duplicate stations in the WHAFIS model causes the WHAFIS 
model to crash. 

• The starting total stillwater values that are populated on the IE card of 
WHAFIS can no longer be changed from the WHAFIS table.  They can only be 
edited under the General Parameters tab.  This avoids confusion of where to 
edit the values and maintains consistency within CHAMP. 

 

 

 



Coastal Hazard Analysis Modeling Program – User’s Manual 

____________________________________________________________________________________________________________________________________  

3 

VERSION 2.0 UPDATE    VERSION 2.0 UPDATE    VERSION 2.0 UPDATE    

 

• The spelling text for two marsh grass (VH card) region types have been revised 
to match the spelling in the FEMA Coastal Guidelines and Specification 
documents.  “Mid Atlantic” has been revised to be “Mid-Atlantic” and “North 
East Gulf Mexico” has been revised to “Northeastern Gulf”. 

• WHAFIS now has the capability to record comment lines in the input file as 
well as the output file.  This feature for input has been added to CHAMP in the 
WHAFIS table for input of the CM comment line and the PS comment line. 

• The WHAFIS 4.0 help file has been added under the CHAMP help menu. 

• The 2% wave runup value will now be calculated by CHAMP and displayed 
next to the average runup value in the RUNUP program. 

• The CHAMP internal MS Access database has been upgraded to work with 
Access versions up to Access 2003. 
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  VERSION 1.1 UPDATE    VERSION 1.1 UPDATE    VERSION 1.1 UPDATE    

CHAMP update to version 1.1, included the following:  

• Previously, CHAMP automatically inserted into WHAFIS a default Marsh Grass 
(MG) base stem diameter as measured in feet.  This introduced an error in 
WHAFIS that needed to be corrected.  WHAFIS requires that the base stem 
diameter be measured in inches.  This CHAMP revision enables the user to use 
the WHAFIS program default values unless more specific information is 
available. 

IMPORTANT NOTE: Existing users of CHAMP will need to modify their 
existing Version 1.0 databases by reselecting each individual MG Card and 
reselecting the plant type from the drop ـ down menu.  This action is necessary 
in order to change previously entered plant parameter values to zeros which 
will enable WHAFIS to use program-provided default values.  

• Previously, CHAMP could not be run on the Microsoft Windows ME operating 
system.  This CHAMP revision can be used on IBM-compatible PCs with the 

Microsoft Windows ME operation system in addition to the Microsoft 

Windows 95/98/NT/2000 operating systems. 

• Erosion assessments in CHAMP are currently performed for dunes with a crest 
above the 1% annual chance (100-year) stillwater elevation (SWEL).  With this 
CHAMP revision, the user can now perform erosion assessments (removal 
case) for ground profiles which are below the 1% annual chance SWEL. 

• Within the WHAFIS module, new station-elevation pairs had to be manually 
inserted at the intersection with the 1% annual chance SWEL.  In this CHAMP 
revision, there is now a function that automatically adds station-elevation 
pairs to the WHAFIS input profile where the ground profile intersects the 
SWEL.  This function will simplify WHAFIS model carding. 

• Previously, CHAMP enabled the WHAFIS program to simulate flood hazards for 
transects which extended in distance to only four digits (i.e. 9,999 ft).  By only 
populating the WHAFIS program input file with station values to the whole foot 
increment, CHAMP Version 1.1 now has the ability to simulate flood hazards 
for transects which extend in distance to five digits (i.e. 99,999 ft) in order to 
better accommodate LIDAR datasets. 
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Chapter 1:  Introduction 

1.1 What is the Coastal Hazard Analysis Modeling Program (CHAMP)? 

Since the 1970s, the Federal Emergency Management Agency (FEMA) has routinely 
established and updated standard methodologies for performing coastal hazard 
assessments of fine scale wave phenomena associated with hurricane storm surges or 
northeaster flooding effects.  These methodologies include storm-induced erosion 
treatments, wave height analyses, and wave runup analyses.  The storm-induced 
erosion treatment adopted by FEMA in 1988 is a schematic treatment of expected 
erosion quantities and geometries; this treatment is performed manually by 
engineers.  There are two existing FEMA computer programs for wave height analysis: 
the 1989 Wave Height Analysis for Flood Insurance Studies (WHAFIS 3.0) program 
and the 1991 wave runup analysis (RUNUP 2.0) program.  Both are DOS-based 
versions.  The WHAFIS 3.0 program has been updated in 2007 to WHAFIS 4.0 to 
include the wave height modeling for the 0.2 % annual chance event.  CHAMP now 
also includes a mode to model the 0.2% annual chance event.  These analyses 
establish the wave crest elevation (SWEL plus wave height) and wave runup elevation 
(SWEL plus wave runup height) at each representative transect along the coast.   

Historically, these coastal hazard assessments (erosion, wave height and wave runup) 
had to be performed separately for each transect, and there was no graphical interface 
through which an engineer could collectively review the results obtained from these 
assessments.  Combining the results of the individual assessments into a per transect 
graphic display of the respective flood hazard zones and Base (1% annual chance) 
Flood Elevations (BFEs) (the wave envelope) was typically plotted by hand or done 
with a spreadsheet.  Often, changing a single input parameter can mean that all three 
assessments must be re-run, and the results replotted.  This process is cumbersome 
and time-consuming.  As part of FEMA’s map modernization efforts, this process has 
been updated. 

CHAMP is a Windows-interfaced Visual Basic language program that allows the user 
to enter data, perform coastal engineering analyses, visualize and tabulate results, 
and chart summary information for each transect within a user-friendly graphical 
interface.  With CHAMP, the user can import digital elevation data; perform storm-
induced erosion treatments, wave height analyses, and wave runup analyses; plot 
summary graphics of the results; and create summary tables and reports in a single 
environment. 

With this User’s Manual, we are releasing Version 2.0 of CHAMP for use by FEMA 
offices, study contractors, and coastal engineering firms.  Please be advised that this 
User’s Manual has been formatted and developed for direct application with this 
CHAMP Version 2.0 release and is, therefore, subject to some changes and 
limitations.  These limitations include: 

• CHAMP is designed to be used only on IBM-compatible PCs with either 
Microsoft Windows 95, 98, NT, ME, 2000, or XP operating systems. 

• CHAMP should be applied only to the Atlantic Ocean, Caribbean Sea, and Gulf 
of Mexico coastal regions for coastal flood hazard assessments relative to the 
National Flood Insurance Program. 
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• Existing WHAFIS and RUNUP input files cannot be imported directly into 
CHAMP.  Data associated with these files need to be reentered into the initial 
Data Entry Program and respective model applications. 

• CHAMP follows a “linear” orientation of coastal analyses.  Any editing or 
addition/deletion of data is not automatically saved in the preceding 
programs. 

• Automated mapping features associated with the CHAMP software have not 
been fully developed.  The graphics can be saved as a .dxf file for use with 
other CADD or GIS applications. 

CHAMP is composed of six programs, each of which includes a main operational 
component to perform coastal flood hazard assessments and to identify flood zones.  
These six programs include: 

• Program 1:  Transect Description/Parameter Entry 

• Program 2:  Transect Data Entry and Editing 

• Program 3:  Erosion Treatment (if applicable) 

• Program 4:  Wave Height Analysis 

• Program 5:  Wave Runup Analysis 

• Program 6:  Summary Tables and Graphics for Mapping 

These programs appear on the CHAMP Main Menu Button Bar as follows: 

Program 1:

Transect Description/

Parameter Entry

Program 3:

Erosion Treatment

Program 2:

Transect Data Entry

and Editing

Program 4:

Wave Height Analysis

Program 5:

Wave Runup Analysis

Program 6:

Summary Tables

and Graphics
 

The flowchart on the following page outlines the general operating procedures for 
running CHAMP.  Detailed instructions and flowcharts for setting up and running 
CHAMP and its six operational programs are included in Chapter 3 (Running CHAMP) 
and Chapter 4 (Program Operation).
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Select to model the 
1% or 0.2% annual 
chance event in the 
main project window 

If transect data and profile 
already eroded or erosion is 
not applicable, proceed to 
Wave Height Analysis Program 
4 and/or Wave Runup 
Analysis Program 5.  If erosion 
treatment is necessary, 
proceed to Erosion Treatment 
Program 3 

General Operating Procedure for Running CHAMP 

Open New or 
Existing Project 

Enter transect 
description 
information 

Enter project 
Information 

PROGRAM 1 
Transect 

Description/ 
Parameter Entry 

Select Transect 

Enter detailed 
transect 
parameters 

START 

PROGRAM 3 
Erosion 
Treatment 

Erosion graphic 
editor 

Compute dune 
reservoir based on 
selection of points 

Compute eroded profile 
based on selection of 
points and balance 
between eroded and 
deposited areas (for 
retreat only) 

Create and display output 

Create eroded 
profile data 

PROGRAM 5 
Wave Runup 
Analysis 

RUNUP data 
input table 

Determine 
profile 
segmentation 
and enter 
required data 

Run RUNUP 

View RUNUP 
output in 
tabular and 
graphic form 
and edit if 
necessary 

PROGRAM 6 
Summary 
Tables and 
Graphics for 
Mapping 

Determine 
information to 
include in final 
summary graphics 
or tables 

Adjusted 
transect input 

Transect input 

Eroded profile 
modeling 

WHAFIS 
modeling 

RUNUP 
modeling 

PROGRAM 4 
Wave Height 
Analysis 

WHAFIS data 
input table 

Determine 
transect 
segmentation 
and enter 
required data 

SWEL changes 

WHAFIS input 
summary table 

Run WHAFIS 

View WHAFIS 
output in 
tabular and 
graphic form 
and edit if 
necessary 

Enter transect 
data—station, 
elevation, and 
source data 

Create adjusted 
transect data 

PROGRAM 2 
Transect Data 
Entry & Editing 
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1.2 How To Use this User’s Manual 

This User’s Manual contains the instructions and specifications needed to run 
CHAMP successfully.  Prior to running CHAMP for the first time, users should: 

• Have a good understanding of FEMA’s coastal flood hazard mapping program 
and the procedures for updating and revising a Flood Insurance Study (FIS) 
and FIRM; 

• Have a good understanding of and demonstrated expertise in coastal 
engineering analyses, including storm-induced erosion, storm surge flooding, 
wave height generation and attenuation, wave runup, and wave overtopping.  

The theory and procedures for these analyses are detailed in the Guidelines 

and Specifications for Flood hazard Mapping Partners – Appendix D: Guidance 

for Coastal Flooding Analyses and Mapping (April 2003) as well as in any 
subsequent updates or procedure memorandums; these documents will be 
referred to as G&S throughout this User’s Manual; 

• Be familiar with the functions and assumptions of FEMA’s WHAFIS 4.0 and 
RUNUP 2.0 programs, and their respective user manuals; 

• Be familiar with the Microsoft Windows 95/98/NT/ME/2000/XP environment; 
and 

• Be familiar with the operation of a CADD program. 

This manual takes the user through the program using many illustrations of the 
various menus, input screens, and results screens.  After reading the manual, the 
user should be ready to start using the program.  Throughout the manual, the user is 
asked to select items from pull-down menus or click on objects.  Unless otherwise 
noted, the user should left-click to select an item. 

The text of certain CHAMP operational features has been enhanced to help the user.  
Enhanced text features include: 

• Main Menu Button Bar Icons  are placed in a box and in bold; 

• Command Buttons are placed in a box and not bold; 

• Text Fields and pull-down menu items are underlined; and 

• Windows are in bold. 

1.3 Acknowledgments 

CHAMP was designed and developed by Dewberry & Davis LLC for FEMA. 
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Chapter 2:  Installing CHAMP 

CHAMP is a program written in Visual BASIC.  This chapter contains the following 
sections: 

• Program Specifications 

• System Requirements 

• Installation Procedures 

2.1 Program Specifications 

CHAMP is a stand-alone, menu-driven Microsoft Windows-based program written in 
Visual BASIC.  CHAMP can be downloaded from the FEMA web site, which includes 
the program, utilities, data components, user’s manual and the G&S. 

2.2 System Requirements 

The minimum requirements for installing and running CHAMP include: 

• IBM-compatible PC (a 100 mHz or higher processor is recommended) 

• Microsoft Windows 95, 98, ME, NT, 2000, or XP Operating System 

2.3 Installation Procedures 

CHAMP Version 2.0 is an update to the existing CHAMP Version 1.2.  Instructions are 
provided below for both CHAMP ‘Current Users’ and ‘New Users’. 

Current Users 

Existing users should follow the instructions below to update CHAMP: 

1. Copy the ‘champ.exe’ and ‘users.pdf’ files from the CHAMP Version 2.0 CD or 
from http://www.fema.gov/plan/prevent/fhm/dl_champ.shtm to a local 
directory where CHAMP files are presently installed on your computer (i.e., 
C:\Program Files\CHAMP).  These files should replace the existing ‘champ.exe’ 
and ‘users.pdf’ files presently in this directory. 

 
2. Double-click on ‘champ.exe’ to operate CHAMP Version 2.0. 
 
3. Select About in the Help drop-down menu to see if ‘Version 2.0’ has been 

correctly installed. 
 
New Users 
 
New users should access http://www.fema.gov/plan/prevent/fhm/dl_champ.shtm  
and follow the instructions under ‘Download CHAMP Version 2.0’ to install CHAMP. 
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General Information 
 

CHAMP should not be installed on a network drive as running CHAMP from a 
network may cause it to run improperly. 

If a question comes up asking if a file should be replaced by a newer version, the user 
needs to make sure that replacing the older file will not affect the operation of another 
program.  Also, CHAMP may not run properly if the user keeps older versions of the 
files to be replaced.  Users should consult with their system administrator if they are 
unsure. 

NOTE:  Sample data are provided in the “Samples” folder, which is accessible by 

clicking Open on the Main Menu Button Bar. 
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Chapter 3:  Running CHAMP 

This chapter outlines the program capabilities of CHAMP.  It describes the following 
components of CHAMP: 

• File Organization 

• Main Menu Button Bar Description 

• Getting Started 

3.1 File Organization 

To organize general project information and transect data, CHAMP generates one 
.mdb file (MS Access database file).  To maintain data integrity, the user is limited to 
read-only access to the .mdb file.  Transect data files for WHAFIS and RUNUP are 
stored in a subfolder with the same name as the .mdb file.  WHAFIS data and output 
file names begin with the prefix “W” followed by the name assigned to the transect.  
For example, transect 3 in CHAMP will have input and output files named W3.dat and 
W3.out, respectively.  RUNUP files follow the same syntax except the prefix is “R.”  For 
the 0.2% annual chance modeling the file name will be followed with a “n” as in 
“W10n.”  WHAFIS and RUNUP file names are relatively short because both programs 
operate on a DOS platform, which accepts file names of no more than eight 
characters.  Each time WHAFIS or RUNUP is executed, the output files are 
overwritten. 

The following example is for a project named “Simple Coast,” with two transects, 
stored in the root X directory: 

Directory Name Type 

X:\ Simple Coast.mdb MS Access Database 

 Simple Coast\ File Folder 

X:\Simple Coast\ R1.dat/R1n.dat DAT File 

 R1.out/R1N.out OUT File 

 R2.dat/R2n.dat DAT File 

 R2.out/R2n.out OUT File 

 W1.dat/W1n.dat DAT File 

 W1.out/W1n.out OUT File 

 W2.dat/W2n.dat DAT File 

 W2.out/W2n.out OUT File 

 1.dxf/1n.dxf Graphic file 

 2.dxf/2n.dxf Graphic file 

 

To avoid overwriting an existing project file, it is recommended that the user create a 
unique folder name (which should not be changed) for each project or that the user 
store the files on a CD-ROM. 
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3.2 Main Menu Button Bar Description 

After opening CHAMP, and then clicking Start on the initial splash screen, the Main 
Menu window including the Main Menu Button Bar will appear.  The Main Menu 
Button Bar, shown below, is the main graphical interface of CHAMP and allows the 
user to access the programs in a logical sequence. 

Main Button Bar

Create a new
project or open an
existing project

Selected
transect
information

Selected
transect
data Analyses and modeling of

selected transect

Summary of
analyses for

selected transect

 

3.3 Getting Started 

To load an existing project or create a new project, and enter all necessary data, the 
following seven steps must be performed. 

Enter project information: 
Step 1. Create a new project, or load an existing project. 
Step 2. Enter general project information—select a transect for data 

entry/editing. 

Enter transect information: 
Step 3. Enter/edit general information for the selected transect. 
Step 4. Enter station and elevation data for the selected transect. 
Step 5. Adjust transect reference station to zero elevation; this is 

required to create necessary data tables for input to erosion 
analyses and wave modeling. 

Step 6. Return to main project window and repeat steps 3 through 5 
for each additional transect. 

Step 7. Go to Erosion Assessment, WHAFIS, RUNUP for analyses and 
modeling of selected transect. 

These seven steps are detailed in Chapter 4 and in the flowchart titled “Project and 
Transect Data Entry Procedures” at the end of section 4.2.  Before the Erosion 
Assessment, WHAFIS, RUNUP, and Summary Programs can be accessed, all of the 
information for Program 1:  Transect Description/Parameter Entry and Program 2:  
Transect Data Entry and Editing must be completed.  After entering the initial 
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transect data in Programs 1 and 2, other elements in Programs 3 through 6 can be 
utilized by clicking on the respective buttons. 
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Chapter 4:  Program Operation 

This chapter provides an overview of the transect data set up, coastal engineering 
analysis and modeling, and summary graphical display components of CHAMP.  There 
are two programs for the transect data setup, three programs that make up the 
analysis portion, and a final program to display summary tables and graphs: 

• Program 1:  General Transect Description and Parameter Entry 

• Program 2:  Transect Data Entry and Editing 

• Program 3:  Erosion Treatment (if applicable) 

• Program 4:  Wave Height Analysis 

• Program 5:  Wave Runup Analysis 

• Program 6:  Summary Tables and Graphics for Mapping 

4.1 Program 1:  General Transect Description and Parameters 

1. Load a Project 

To create a new project: 

a. Click NEW on the Main Menu Button Bar (or choose New Project from the 
File drop-down menu). 

b. Select/create the folder to store the CHAMP files. 

c. Enter the File Name, which will create a .mdb file, and data folder with the 
same name and click Save. 

To open an existing project: 

a. Click OPEN on the Main Menu Button Bar (or choose Open Project from 
the File drop-down menu). 

b. Go to the folder containing the .mdb file for the project. 

c. Select and open the .mdb file. 

2. To import multiple transect data: 

a. Choose Import Data from the File drop-down menu.  The following window 
will appear: 

 

 

Existing projects created in previous versions of CHAMP can also be opened 
using this new version.  CHAMP will convert the file to the newer version 
format.  Be sure to back up the older CHAMP version project files before 
opening in the new version to prevent any accidental data loss. 
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b. STEP 1:  Click on the BROWSER button to select a file name and location 
for the new project.  Then fill in the appropriate project information.  Click 

on NEXT to move on. 

c. STEP 2:  Select the BROWSER button to select the file where the transect 
data are located. The files that can be imported are standard comma-
delimited text files (.csv), MS Excel (.xls), dBASE (.dbf), and MS Access 
(.mdb) that contain transect numbers and station/elevation pairs.  If 
databases or spreadsheets contain multiple tables or worksheets, select 
the data table or worksheet with the transect data you wish to import.  All 
data must be in one data table or worksheet.  Only one data table or 
worksheet can be imported.  Select the data type, and then select the data 
field that contains that particular data type.  If you are not sure what is 
contained in the data fields, a display of the first few rows of the data is 
shown.  Transect, Station, and Elevation are the only required fields.  The 
source field is not required to import data. 

The data file with the transect information needs to be arranged as shown 
below in order for the data to import properly.  One column or field needs 

to have the transect numbers that each station/elevation pair is related 
to.  That is, each data point must have an associated transect number.  
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There must also not be any blank rows separating transects or data points 
and no text title rows. 

 

Once all the appropriate data are selected, click the OK button to import the 

transect data and create the project. 

3. Enter General Project Information 

 

 

After loading the project, the main Project Information window will appear.  These 
fields will be used in the WHAFIS and RUNUP programs for the title block.  The path 
and name of the .mdb file are visible in the Project Database field; however, the user 
cannot modify this field. 

• Project Title:  User-specified to sufficiently identify the project site. 

• Modeler Name:  Self-explanatory. 

• Community Name:  Name of community to which this analysis is being 
applied.  Should be the same as the community name on the FIRM. 

• Client Name:  Self-explanatory. 



Coastal Hazard Analysis Modeling Program—User’s Manual 

CHAMP Version 2.0 August 2007  14 

• Vertical Datum:  All project data should reference the same vertical datum 
used for the FIRM.  Currently, the user has only two choices for vertical 
datum.  These are the North American Vertical Datum of 1988 (NAVD 88) and 
the National Geodetic Vertical Datum of 1929 (NGVD 29).  This field, as well as 
the Projection and Estimated FIRM Scale fields, will be used for automated 
mapping, which will be developed in future versions of CHAMP. 

• Projection:  Same requirements apply as for vertical datum.  The choices are 
currently Latitude/Longitude, State Plane, and Universal Transverse Mercator, 
also known as UTM. 

• Transect Unit System:  English (feet) or Metric (meters). 

• Estimated FIRM Scale:  Anticipated scale of the FIRM to be created.  Current 
options include (1 inch = x feet) 400, 500, 800, 1,000, and 2,000. 

• Number of Transects:  This field establishes the number of transect files that 
will be opened for data entry.  The user can increase the number of transects 
at any time. 

After entering/editing data, click on the pull down menu in the upper right hand 
corner of the window labeled Transect ID to select a transect.  To run the Erosion 
Treatment, Wave Height Analysis, and Wave Runup Computation programs in 
CHAMP, the user must first create and/or select a transect to be analyzed.  

To add, delete, or rename a transect to an existing list, follow these steps: 

From the main Project Information window, click the Transect menu.  
Here there are three items: Edit Transect ID, Add Transect, and Delete 
Transect.  Selecting any one brings up a new window where transects can 
be added, deleted or renamed.  Transect ID’s can be letters or numbers, up 
to 15 characters. 

     

Also there is an item here called Station Rounding to the Whole Foot.  Once 
this function is executed the decimal numbers can not be recovered.  Also 
all tables will now display the entire station number without rounding.  
This is useful when detailed topographic data such as LIDAR data is used 
to extract ground profiles and may have numbers out to multiple decimal 
places.  For long transects this may present a problem because the 
WHAFIS program only allows for 6 spaces for the station number including 
the decimal point.  Any station number greater than 9999 does not allow 
the use of any decimal places. 
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4. Enter General Transect Information 

In the Transect General Information window, information about the location, type, 
and general characteristics of the selected transect is entered/edited.  Click on the 

General button on the main Project Information window to open the Transect 

General Information window: 

 

The Description tab is for entering general transect information as follows: 

• Transect Type:  Description of the shoreline type that most closely matches the 
transect being modeled.  Current choices are Rocky bluff, Sandy bluff-Little 
beach, Sandy beach-Small dune, Sandy beach-Large dune, Open wetland, 
Vertical wall, and Revetment. 

The user can determine which transect is selected by viewing the Transect Status Bar 
located along the top of any program window. 

 

Transect 
Status 
Bar 
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• Description of Transect Location:  Description of the transect’s location relative 
to local fixed landmarks.  The description should be adequate for unmodified 
inclusion in FIS tables. 

• Range and Direction Left:  Looking landward, the Range is the along-shore 
distance to the left of the transect line that the transect is intended to 
represent.  Direction is entered as the bearing of the range away from the 
transect (in degrees North). 

• Range and Direction Right:  Same as Range and Direction Left, but to the right 
of the transect line. 

• Location of Station 0:  Description of the location of the “zero” station to be 
entered in the transect profile data.  The zero station should be located at the 
zero elevation or zero-foot contour line along the shoreline of the flooding 
source.  The unit options for these fields include decimal degrees (dd), meters 
(m), and feet (ft) based on the Projection field input in the main Project 
Information window.  The bearing refers to the orientation of the transect 
looking landward from Station 0.  The unit option for this field is limited to 
decimal degrees. 

• Transect Characteristics:  Physical and cultural description of the area the 
transect is intended to represent.  Include information on the presence 
vegetation, structures or development, and beach material (fine sand, coarse 
sand, cobble, or mud). 

 

 

 

 

 

 

 

 

 

 

 

 

 

If entering information for a new transect and a previous transect exists that 

contains the same information as the new transect, click on the Copy button 

to fill in all the fields with information from a previously entered transect. 

None of the fields described above are required to proceed to the next step; 
none of the information provided in the Transect Description Information 
window will be used for actual engineering computations. 
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5. Enter Detailed Transect Information 

Click on the Parameters tab in the Transect General Information window for 
entering additional details regarding the transect. 

 

 

 

Detailed transect information regarding storm surge and wave parameters and the 
source of the data are entered in the Parameters—Transect General Information 
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window. Units for the majority of the data fields are established in the main Project 
Information window.  For Version 2.0 of CHAMP, the units in the data fields default 
to English.  In future versions, the units will be in English or Metric. 

The following fields are required and must be completed (with the exception of Other 
Flooding Source, which is optional): 

• Flooding Source:  Name of the body of water for which flood hazards are being 
analyzed (e.g., Atlantic Ocean, Gulf of Mexico, or inland bay or sound). 

• 10% chance SWEL:  10% annual chance (10-year) SWEL without wave setup, 
referenced to the stated vertical datum.  Must be specified, even if value is 
“zero.” 

• 2% chance SWEL:  2% annual chance [50-year] SWEL without wave setup, 
referenced to the stated vertical datum. 

• 1% chance SWEL:  1% annual chance [100-year] SWEL without wave setup, 
referenced to the stated vertical datum.  Also referred to as “storm surge.”  
Computed wave setup will be entered separately.  It is important to use a 
decimal format with one decimal digit (tenths) in this field. 

• 0.2% chance SWEL:  0.2% annual chance [500-year] SWEL without wave 
setup, referenced to the stated vertical datum.  Also referred to as “storm 
surge.”  Computed wave setup will be entered separately.  It is important to 
use a decimal format with one decimal digit (tenths) in this field. 

• Mean High Water Elevation and Mean Low Water Elevation:  Referenced to the 
stated vertical datum.  Must be specified, even if value is “zero.” 

• Fetch Length:  Measured in miles, the maximum open water reach over which 
storm-induced winds are expected to occur.  Maximum effective value is 24 
miles.  A “zero” can be entered if deepwater wave conditions are specified.  

• 1% Significant Wave Height:  Wave height associated with the 1% annual 
chance storm event, given in feet.  Must be specified for WHAFIS and RUNUP 
analyses.  A “zero” can be entered if the subject area has a restricted fetch and 
the Fetch Length will be used to calculate a wave height or if only analyses for 
the 0.2% annual chance event are being run. 

• 0.2% Significant Wave Height:  Wave height associated with the 0.2% annual 
chance storm event, given in feet.  Must be specified for WHAFIS and RUNUP 
analyses.  A “zero” can be entered if the subject area has a restricted fetch and 
the Fetch Length will be used to calculate a wave height or if only analyses for 
the 1% annual chance event are being run. 

• 1% Deepwater Wave Period:  Wave period associated with the 1% annual 
chance deepwater wave height.  Required for WHAFIS and RUNUP analyses.  A 
“zero” can be entered if the subject area has a restricted fetch and the Fetch 
Length will be used to calculate a wave period or if only analyses for the 0.2% 
annual chance event are being run. 

• 0.2% Deepwater Wave Period:  Wave period associated with the 0.2% annual 
chance deepwater wave height.  Required for WHAFIS 4.0 and RUNUP 2.0 
analyses.  A “zero” can be entered if the subject area has a restricted fetch and 
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the Fetch Length will be used to calculate a wave period or if only analyses for 
the 1% annual chance event are being run. 

• 1% Wave Setup Magnitude:  Value, in feet, of apparent wave setup effect to be 
added to 1% annual chance SWEL.  Must be specified, even if value is “zero.” 

• 0.2% Wave Setup Magnitude:  Value, in feet, of apparent wave setup effect to 
be added to 0.2% annual chance SWEL.  Must be specified, even if value is 
“zero.” 

• 1% & 0.2% WINDOF:  Wind speed associated with the 1% & 0.2% annual 
chance storm events for the OF card in WHAFIS.  If left blank the default will 
be used by the WHAFIS program. 

• 1% & 0.2% WINDVH:  Wind speed associated with the 1% & 0.2% annual 
chance storm events for the VH card in WHAFIS.  If left blank the default will 
be used by the WHAFIS program. 

• 1% & 0.2% WINDIF:  Wind speed associated with the 1% & 0.2% annual 
chance storm events for the IF card in WHAFIS.  If left blank the default will be 
used by the WHAFIS program. 

• Source of Annual Chance Stillwater Elevations:  Description of methods or 
references used to determine the SWEL. 

• Source of Mean High and Low Water Elevations:  Description of the methods or 
references used for determining specified mean high water (MHW) and mean 
low water (MLW) elevations. 

• Type of Event:  Description of the type of flooding event being analyzed.  Drop-
down list includes such options as Northeaster and Hurricane. 

• Source of Wave or Fetch Data:  Description of methods or references for 
determining wave or fetch conditions. 

• Method for Determining Wave Setup Magnitude:  Description of methods or 
references used for determining wave setup magnitude. 

The Other Flooding Source data fields at the bottom of window are optional.  They can 
be used to enter information about a flooding source not related to the main flooding 
source as a transect traverses landward.  An example of this is when there is a barrier 
island with a body of water between the island and the mainland. 

Click OK to return to the main Project Information window, or click the close button 

( X ). 
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4.2 Program 2:  Transect Data Entry and Editing 

The Transect Edit Program window can be opened by clicking the TRANSECT button 

on the Main Menu Button Bar.  Transect ground profile station and elevation data 
are entered here.  The data can be the unadjusted, non-eroded profile information or 
eroded profile information and will be used in all analyses and modeling programs.  
For this version of CHAMP, all station and elevation data for the transect must be in 
feet. 

 

Transect station and elevation data can also be imported by selecting the Import 
menu item under the File menu.  CHAMP only allows importing comma-delimited text 
files (.csv) for importing station and elevation data for a transect.  This works much 
the same as importing project data described above.  

The Station and Elevation column data must extend seaward to at least the zero 
shoreline.  However, it is often necessary for the data to extend much further offshore 
if dune-retreat-eroded-profile transects or wave runup are to be modeled.  Profile data 
should extend onshore (inland) to a point where coastal stillwater flooding likely 
ceases or to the limit of maximum runup elevation. 

The Source column lists the source of the transect profile data.  Options for this 
column include Surveyed, Topographic Map, Bathymetric Map, Global Positioning 
System (GPS), Digital Terrain Metadata (DTM), and Light Detection and Ranging 
(LIDAR) data. 

To enter additional station/elevation data points, enter data at the row indicated by 

the  located at the bottom left corner of the input data fields. 
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Command buttons at the top of the Transect Edit Program window include: 

• Transect:  Displays Transect Edit window 

• Adjusted:  Displays Adjusted Transect Edit window.  Using this button 

creates the adjusted station-elevation table in the database, which will be used 
by the other programs.  If this table is not created, the other programs cannot 
be run.  If a (0,0) point is not available, this button adjusts the profile 
accordingly by interpolating or adding a zero elevation (NGVD 29 or NAVD 88) 
and corresponding station, which is required by WHAFIS.  Notice that this 
dialog box is similar to the Transect Edit window, except for the addition of 

the Adjusted Station column.  This column displays the interpolated (0,0) 
shoreline point, if such a point was not a part of the original transect data.  
The Source column contains the text “interpolated” for the interpolated (0,0) 
point. 

 

• Graph:  Displays either the transect or adjusted transect data in graphical 

format depending on which table is displayed at the time this button is 

clicked. The Insert and Remove buttons are visible only in graph mode and are 

used to insert and remove data points in the graphical view of the transect.  To 

view the changes made, the Refresh button must be clicked.  The database 

table will not get updated until the Update table menu item is selected from 
the Graph menu.  To undo the changes made to the graphical display of the 

transect, click on the Transect button or exit the Transect Edit program 

without updating the table.  A point identifying the Primary Frontal Dune 
(PFD) can be added when viewing the adjusted transect graph.  Under the 
Graph menu, select Landward Toe (PFD), then select the point along the 
transect where the landward limit of the primary frontal dune is located.  To 
learn about the function of the graphical displays, see section 4.7 below titled 
Graphic Controls. 
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• Refresh:  Reformats Field Station and Elevation columns in numerical order of 

station value if new data are entered.  New station and elevation data can be 
entered at the bottom of the data entry fields. 

After inputting the transect information as summarized in the Project & Transect Data 
Entry Procedures flowchart (on the following page), CHAMP allows the user to analyze 
and model data.  The remaining sections of Chapter 4 offer a detailed description of 
Programs 3 through 6.

NOTE: The Adjusted Transect graphic must be displayed in order to open up 
the Erosion Assessment Program Window. 
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4.3 Program 3:  Erosion Treatment 

1. Introduction 

Wave analysis transects normally undergo FEMA’s standard erosion treatment before 
being used as input to the WHAFIS 4.0 or RUNUP 2.0 models.  The G&S should be 
referenced for more detailed descriptions of the terms and procedures used for 
performing the erosion treatment.  For cases where the existing transect data already 
represent the eroded profile, or erosion will not be applicable (i.e., hardened shoreline 
or rocky coast), the user can bypass this program.  It is particularly important that 
the 1% or 0.2% annual chance SWEL and profile data be firmly established before 
performing the erosion treatment. 

CHAMP assists the user in performing the erosion treatment and adjustment through 
the Erosion Assessment Program window, which is accessed by choosing the 

EROSION button on the Main Menu Button Bar. 

The Erosion Assessment Program will display the adjusted transect data on a graph 
of Elevation versus Distance (station), with increasing stations being landward.  
Horizontal lines representing the 1% and 10% annual chance SWELs (without wave 
setup) are also shown.  The interactive user controls are accessed through the tool 
bar at the top of the editor window.  These controls include the following functions 
(left to right): 

• Set Peak 

• Set Toe 

• Set Face Slope 

• Set Approach Slope 

Before proceeding on to the remaining programs for performing the analysis 
the user can choose whether to work with the 1% annual chance wave 
modeling mode or the 0.2% annual chance wave modeling mode by selecting 
the appropriate button on the Main Menu window.  This will allow for 
working with the data separately for each mode.  The data for each mode is 
stored separately.  Each window under the analysis Programs will identify 
which mode is being worked on in the title bar at the top of each window. 

 

Mode selection 
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• Set Seaward Slope 

• Set Remove Slope 

• Computed Reservoir Area 

• Deposit Area 

• Erosion Profile Status 

• Total Eroded Area 

• Eroded area above SWEL 

In addition, the user must enter or confirm default values for one or more of the 
following parameters, as applicable:  Seaward Slope (1/12), Face Slope (1/1), and 
Approach Slope (1/40) for “Retreat” profiles; or Removal Slope (1/50) for “Removal” 
profiles.  Note:  default values are in parentheses; slopes are vertical/horizontal. 

To get a closer look at the transect profile segments, use the View item under the 
Graph menu or right-click on the graphic screen to activate a prompt to the following 
functions:  Zoom Window, Zoom In, Zoom Out, Full Extent, and Pan.  See section 4.7; 
Graphic Controls for a description of the View commands as well as all graphic 
commands. 

Setup under the Graph menu is used to adjust axes scales and intervals.  See section 
4.7 for a description of the Setup options. 
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The erosion assessment analysis is performed graphically by selecting points along 
the profile.  The program requires the user to select these points.  The following step-
by-step instructions outline the procedures for performing a frontal dune erosion 
treatment within CHAMP.  Instructions consider frontal dune erosion treatment for 
ground profiles where the dune crest is:  A) above; and B) below the 1% or 0.2% 
annual chance SWEL. 

2. Dune Crest Above 1% or 0.2% Annual Chance Stillwater Elevation 

a. Establishing Dune Reservoir 

Selecting the peak of the dune: 

Click on the Peak field on the top of the window.  Click on the profile where the 
appropriate peak of the dune is located.  The coordinates of the point selected will be 
shown in the data fields next to the Peak field.  The program will draw in the dune 
reservoir and calculate the area of the reservoir and show this value in the Reservoir 
field.  If the peak needs to be moved or reselected, this can be done by clicking on the 
Peak field again and selecting the new dune peak location on the transect. 

NOTE:  The minimum value of the dune reservoir before the dune is considered 
removed is the FEMA standard value of 540 sq. ft. for the 1% annual chance flood and 
1,030 sq. ft. for the 0.2% annual chance flood for the or the Atlantic Ocean, Caribbean 
Sea, and Gulf of Mexico.  The program will also show whether the dune is removed or 
retreated in the Status field. 

The reservoir is calculated as the cross sectional area between the SWEL (without 
wave setup), a vertical line drawn through the dune peak, and the transect ground 
profile for the foreshore dune area (seaward of the dune crest).  If this area is less 
than the critical area of 540 sq. ft. for the 1% annual chance flood or 1,030 sq. ft. for 
the 0.2% annual chance flood, the profile adjustment will be for dune removal, and 
noted as “Remove” in the Status field.  If the computed area is greater than or equal to 
the critical area, the Status field will be adjusted to reflect dune retreat, and noted as 
“Retreat” in the Status field. 

b. Method for Dune Removal 

If the dune is eroded, follow the steps below: 

Click the Toe field and select the appropriate place along the profile that best 
represents the location of the dune toe.  The toe of the dune can also be approximated 
by the intersection of the 10% SWEL with the seaward side of the ground profile.  The 
dune toe can be changed by clicking on the Toe field again and reselecting the point 
on the profile. 

The program defaults to using the standard slope for an eroded profile as 1 on 50.  If 
an alternate slope is desired, the value can be changed in the Remove field.  Click on 
the Remove field button.  The program will draw the eroded profile and calculate the 
eroded area as shown in the Total Eroded Area field. 
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c. Method for Dune Retreat 

If the dune is retreating, follow the steps below: 

Define the eroded area of the dune.  First click the Face field and select the position 
for the 1-on-1 eroded dune face that is a best initial guess where the eroded area may 
be equal to 540 sq. ft. for the 1% annual chance flood and 1,030 sq. ft. for the 0.2% 
annual chance flood.  Check the Eroded above SWEL field to see what the eroded area 
is.  If the eroded area is not equal to or close to 540 sq. ft. for the 1% annual chance 
flood and 1,030 sq. ft. for the 0.2% annual chance flood, then re-select the position of 
the eroded dune face and check the Eroded above SWEL field again.  Repeat this until 
the eroded area is equal to or close to the 540 sq. ft. for the 1% annual chance flood 
and 1,030 sq. ft. for the 0.2% annual chance flood. 
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Determine the seaward slope and position that best gives a deposition area that 
closely matches the eroded area (check the Deposit field).  Select the Seaward field 
and then select the position for the 1-on-12 slope by clicking on the graph.  This will 
place a 1-on-12 slope line on the screen.  The seaward slope will be placed at the 
position of the mouse cursor, and the program will calculate the deposition area as 
shown in the figure below. 

 

Check the Deposit field to see if it matches the Total Eroded Area field.  If they match 
or are close, the erosion treatment is complete.  If they are not close, the selection of 
the seaward slope can be repeated until the deposition area matches the eroded area. 

3. Dune Crest Below 1% or 0.2% Annual Chance Stillwater Elevation 

For profiles where only the dune crest is below the 1% or 0.2% annual chance SWEL, 
follow these instructions: 
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Click on the Peak field on the top of the window.  Click on the profile where the 

appropriate peak of the dune is located.  The following window will appear.  Click Yes 

to proceed with removing the dune. 

 

Click the Toe field and select the appropriate place along the profile that best 
represents the location of the dune toe.  The toe of the dune can also be approximated 
by the intersection of the 10% SWEL with the seaward side of the ground profile.  The 
dune toe can be changed by clicking on the Toe field again and reselecting the point 
on the profile. 

The program defaults to using the standard slope for an eroded profile as 1 on 50.  If 
an alternate slope is desired, the value can be changed in the Remove field.  Click on 
the Remove field button.  The program will draw the eroded profile. 

For profiles where the entire ground profile is below the 1% or 0.2% annual chance 
SWEL, the following window will automatically display when initially entering the 
Erosion Assessment Program: 

 

Click on OK to remove the dune and follow the instructions above for selecting the toe 

and drawing the eroded profile. 

4. Saving and Exiting the Erosion Treatment Model 

To clear out the erosion profile in the database, click the Clear Model menu item 
under the File menu.  This can be used when an erosion analysis was performed 
previously and the user wants to re-do the erosion analysis or if the user wants to run 
WHAFIS or RUNUP with the non-eroded adjusted transect data.   

 

WARNING: Once the clear model command is selected the erosion table in the 
database is cleared and can not be undone or brought back.  The user needs to 
perform the erosion analysis again. 
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When the user is satisfied with the eroded profile slopes and the eroded and deposited 
areas, the erosion profile needs to be saved in the database by selecting the Save 
Model menu item under the File menu.  CHAMP will then create a data table for the 
eroded profile, which will be used as the WHAFIS 4.0 and RUNUP 2.0 input files in 
Programs 3 and 4. 

Exit from the Erosion Graphic Editor window by clicking on the window closure  X  

in the upper right corner.  As a precaution, the program will ask if the user wishes to 

save any changes made to the erosion profile.  Click Yes if you wish to save changes 

or No if you wish to disregard any changes made. 
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4.4 Program 4:  Wave Height Analysis 

This program is used to specify the input parameters for and run the Wave Height 
Analysis for Flood Insurance Studies (WHAFIS 4.0) program on the selected transect.  
Consult the G&S for more detailed information on the WHAFIS program.  To begin the 

wave height analysis, click on the WHAFIS button on the Main Menu Button Bar.  

The WHAFIS Program window shown below will open. 

 

1. Transferring adjusted data to WHAFIS Program 

Click the Populate Data item under the File menu to extract data from either the 
eroded transect or the non-eroded transect data entered in the Transect Data Entry 
and Editing Program.  The station and elevation columns in this window will be filled 
in with the transect data.  WHAFIS uses points only from the zero elevation 
shoreward.  These will be the only stations used for WHAFIS input cards.  WHAFIS 
will populate only with data points that are equal to or below the total stillwater level 
(1% or 0.2% annual chance SWEL plus wave setup).  If there are no data points where 
the total SWEL intersects the ground the program will automatically insect data 
points at every occurrence where the profile crosses the total SWEL.  Segments above 
the total stillwater level are automatically considered X zones and are not needed for 
the WHAFIS program.  The WHAFIS 4.0 Program is limited to 1,000 data points per 
transect.  Therefore, some data points may need to be removed before running the 
program. 

2. WHAFIS card selection 

The WHAFIS Card column will be defaulted to the IF card except for the first card.  
The first input card to WHAFIS must always be an IE card.  By clicking on a field for 
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each station, a drop-down menu will appear with all the card options for WHAFIS.  
Click on the appropriate card for each station.  By selecting or double-clicking on a 
card field that requires additional input (e.g., VE, VH cards), an input window will pop 
up for that card.  Fill in all the fields with station-specific information.   

 

3. Annual chance stillwater elevation discussion 

The Total SWEL field for the first station will be filled in with the annual chance SWEL 
plus the setup entered in the Transect Description/Parameter Entry Program.  If 
there is a change in the annual chance SWEL as the transect proceeds inland, enter 
the new annual chance SWEL in this column at the appropriate station.  The SWEL 
change is possible where the transect crosses over a barrier island and extends across 
an inland bay or other secondary flood source.  If the open coast barrier island or 
mainland ground elevations rise above the annual chance SWEL plus setup, the 
transect will terminate.  If the transect extends into a secondary flood source or 
further inland flood areas, then the setup should be taken out of the total SWEL 
value. 

A function exists in CHAMP where station-elevation pairs are automatically inserted 
at all locations where the ground elevation profile crosses the 1% (or 0.2%) annual 
chance SWEL.  Thus, this function will add two points for a profile that rises above 
and then falls below the 1% (or 0.2%) annual chance SWEL.  A station will need to be 
inserted manually where the ground elevation crosses the 1% (or 0.2%) annual 
chance SWEL plus setup.  Further refinements of the SWEL changes and new station 
locations can be made via the graphical display (See Step No. 4).  Refer to the G&S for 
further guidance on WHAFIS modeling for SWEL changes.  See below on how to insert 
a transect point. 

IMPORTANT: When editing the VH card, click on the MG button to enter 

additional data.  When a plant type is selected from the drop-down menu in 
the MG card window, plant parameters will default to zero which implies 
WHAFIS program-provided default values.  The user can also manually enter 
plant parameters in order to override WHAFIS default values.  If entered 
manually, Unflexed Stem Height and Frontal Area Ratio parameters should be 
entered in feet; the Number Density parameter should be entered in inverse 
square feet; and; Base Stem Diameter, Mid Stem Diameter, and Top Stem 
Diameter parameters should be entered in inches.  These units are used in 
WHAFIS, and therefore do not have to be converted. 

Values should not be taken directly from the G&S ‘Table D-12: Significant 
Marsh Plant Types in Each Seacoast Region and WHAFIS Default Regional 
Plant Parameter Data. 
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4. Graph display of WHAFIS input and eroded or adjusted transect data 

Click on the Graph button of the WHAFIS Program window to plot the transect as 

shown in the window below.  Additional data points can be inserted from this window. 

 

The plot will show all of the original adjusted (blue) or eroded (yellow) profile ground 
elevation transect points and line.  The transect points and line being used for the 
WHAFIS input will be represented in magenta.  The total 1% (or 0.2%) annual chance 
SWEL (with wave setup if applicable) will also be plotted as a yellow dashed straight 
line across the graph.  To get a closer look at the profile, as described previously, click 
on View or right-click the mouse on the graphic screen (see section 4.7). 

To add a transect point, click on the Insert button and then click on the point along 

the profile where the additional points are needed.  Click on the Refresh button to 

update the graphic view to see the results of the inserted points.  The station and 
elevation of the new points will not be inserted into the WHAFIS data input table 
until the table is updated by clicking on the Update table menu item under the 

Graph menu.  Click on the Data button or return to the WHAFIS data input table to 

complete the fetch and WHAFIS card fields for the inserted point.  If the inserted 
points are not wanted the results can be undone before the table is updated by 
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switching to the table view and then back to the graph; the inserted points will be 
removed.  If a data point needs to be removed from the WHAFIS input, select the 

points to be removed by clicking on them and then clicking the Remove button.  

Again, the Refresh button needs to be clicked to see the results of the removed points, 

and the table will not be updated until the Update table menu item under the Graph 
menu is selected. 

 

 

 

 

5. WHAFIS computational application 

Click on the Run WHAFIS item under the Program menu WHAFIS Program window to 
execute the WHAFIS program.  A DOS-run window will open; it will appear either 
minimized or opened on screen.  When “Stop – Program terminated” appears in the 
DOS window, the WHAFIS program is complete and the DOS window can be closed.  If 
the WHAFIS program ran successfully, a “WHAFIS RUN finished” box will appear; 
click on the OK button.  If WHAFIS did not run correctly, an error message will appear 
and the input file should be checked for errors. 

6. Graphical display of WHAFIS output data 

Click on the Graph Results item under the Graph menu while in the graphic view of 
the WHAFIS Program window to see a graphical plot of the WHAFIS results.  This will 
bring up a plot of the profile showing input profile, SWELs, and the wave envelope. 

Warning: If the Table button is clicked to return to the table view without 

first updating the table with the inserted or removed data points, the 
changed results of the inserted or removed points will be lost. 
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A hatched color-coded bar at the bottom of the plot represents the different zones: 

• VE Zone—Red 

• AE Zone—Green 

• X Zone—Yellow 

Other lines within the graphical display correspond to the following elevations: 

• Total 1% or 0.2% annual chance SWEL (1% or 0.2% annual chance SWEL plus 
wave setup)—Dark blue line 

• Wave Crest Elevation—Purple line 

• Zone Elevation Designations—Stair-stepped line, the color of which 
corresponds to the zone bar colors at the bottom of the plot. 

7. Return to main data display 

Click on the Data button to return to the WHAFIS input table. 

If the WHAFIS graphic is viewed again the graph will go back to showing the WHAFIS 
input profile.  The Graph Results menu item needs to be selected again to view the 
results to the WHAFIS model. 
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8. WHAFIS data viewing 

The Results menu of the WHAFIS Program window includes the WHAFIS input and 
output results.  The input and output text files, and WHAFIS output files (in six parts) 
can be viewed and printed in table format.  The different output parts are shown 
below. 

Part 1 is the input information. 

 

Part 2 shows the controlling wave heights, spectral peak wave period, and wave crest 
elevations for the data entry points and all WHAFIS interpolated values. 
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Part 3 shows the location of areas above the 1% (or 0.2%) annual chance Total SWEL.  
If no areas are above the 1% (or 0.2%) annual chance surge, no table will be 
displayed.  

 

Part 4 shows the location (if any) of Total SWEL changes. 

 

Part 5 shows the locations (if any) of the V Zone to A Zone boundary (windward) and 
the A Zone to V Zone boundary (leeward). 
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Part 6 shows the station and location of the 1% annual chance (or 0.2% annual 
chance) flood elevation and respective A Zone and V Zone designation.  Refer to the 
G&S for additional details on output interpretation and mapping of coastal areas. 

 

9. Exiting WHAFIS Program 

When finished with the Wave Height Analysis Program, close the WHAFIS windows 

by clicking on the  X  in the upper right corners on each window.  Then, continue 

with Program 5, or proceed to Program 6. 
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4.5 Program 5:  Wave Runup Analysis 

This program is used to run the FEMA RUNUP (Version 2.0) model on the selected 
transect.  The FEMA RUNUP model applies only to runup on sloped beaches.  The 
U.S. Army Corps of Engineers Shore Protection Manual (1984) should be consulted for 
runup on vertical walls and armored rocky revetments.  The G&S should be consulted 
for a detailed description on applying runup and running the FEMA RUNUP model.   

To begin the RUNUP program, click on the RUNUP button on the Main Menu Button 

Bar.  The window shown below will open: 

 

1. Transferring adjusted data to RUNUP program 

Click on the Populate item under the File menu to fill in the Runup Program window 
with data from the transect.  The Station and Elevation columns will be filled in with 
all of the transect eroded profile data points (both offshore and onshore). 

2. Selecting roughness coefficients 

The Description of Surface column will be defaulted to smooth.  By clicking on each 
field for each station, a drop-down menu appears where a selection of the type of 
runup surface can be made.  The Roughness Coefficient column will be defaulted to 1 
for smooth runup surfaces and will adjust automatically based on the Description of 
Surface column input.  Click in the field of each station to change the coefficient. 

3. Transect data point selection for wave runup analysis 
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The Station Status column is for indicating which stations will be used for input into 
the RUNUP model.  The RUNUP Program is limited to 20 data points per transect.  
The selected button indicates that either the station is excluded and will not be used 
as input, or the station will be included for input.  The default is to exclude the 
stations.  Stations or data points can be included or excluded by clicking on the 
appropriate button under Station Status.  All data points landward of the highest 
point on the runup slope should be excluded. 

4. Annotations for selected data points 

The Note column is for entering any comment necessary to describe the runup at a 
particular station.  Just click on the appropriate row and enter the comment. 

5. Setup for RUNUP program 

Selecting the Setup for RUNUP program item under the Program menu opens the 
table shown below. 

 

a. Wave Information 

The Type of Event, Mean Wave Height, Mean Wave Period, and Stillwater 
Elevation data fields will be filled in automatically according to the data 
entered in the Detailed Transect Information window on the Parameter 
tab in the Transect Data Entry and Editing Program.  Adjustments from 
“Significant” to “Mean” wave height and wave period conditions are made 
automatically.  These data can be changed here if necessary. 

b. Defining range for wave height and wave period characteristics 

The Spread data field will be defaulted to 5%.  This field is for specifying 
the range of wave heights and periods for RUNUP to use.  RUNUP will use 
the 5% higher input wave height, the unchanged wave height, and the 5% 
lower wave height, in combination with the 5% higher and lower wave 
period.  An additional spread value of 10% can be specified if the 5% range 
is not deemed significant. 

c. Last slope for extended hypothetical profile 

The Last Slope field is for entering the slope immediately landward of the 
last profile point.  This field defaults to 50 and should be changed to 
represent the current profile. 
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d. Tracking wave runup projects 

The Job Number field is for identifying the RUNUP run and will be used in 
the titles of the RUNUP input and output.  It can be numeric or alphabetic, 
and its default is 1. 

Click on the OK button to continue with the RUNUP analysis. 

6. Graph display of RUNUP input transect data 

Click on the Graph button of the RUNUP Program window to plot the transect.  The 

runup profile and results will be plotted in red.  Additional data points can be inserted 
or removed from the graph window in the same way as described previously in section 

4.4 Wave Height Analysis.  The Refresh button needs to be clicked to see the results 

of the inserted or removed points, and the table will not be updated until the Update 
table menu item under the Graph menu is selected. 

 

 

 

 

7. RUNUP computational application 

Once all input for the RUNUP model is complete, click on the Run RUNUP item on the 
Program menu to run the model.  A DOS-run window will open.  When “Stop – 
Program terminated” appears in the DOS window, the RUNUP program is complete 
and the DOS window can be closed.  If the RUNUP program ran successfully, a 
“RUNUP RUN finished” box will appear; click on the OK button.  If RUNUP did not run 
correctly, an error message will appear. 

8. Display of RUNUP results 

The average runup depth computed from the model results and the 2% runup value 
(Avg. Runup * 2.23) will be displayed in the Avg. Runup and 2% Runup fields in the 
upper right corner of the Runup Program window.  To view the input or output text 
files, click on the Results drop-down menu and select the appropriate choice.  A table 
of the RUNUP results of all wave heights and periods run can be seen by clicking on 
the Results menu and selecting Output Data Table.  A table similar to the one shown 
below will be displayed. 

Warning: If the Table button is clicked to return to the table view without 

first updating the table with the inserted or removed data points, the 
changed results of the inserted or removed points will be lost. 
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9. Graphical display of RUNUP results 

To view a graph of the RUNUP profile and results, click on the Graph Results item 
under the Graph menu while in the graph view.  A line will be drawn showing the 2% 
wave runup elevation.  A window similar to the one shown below will be displayed. 
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This plot shows the profile used in the runup analysis in red and the computed runup 
elevation (average computed runup depth plus SWEL) as a red dashed line.  Click on 
the Data button to return to the RUNUP input window 

 

 

 

 

10. Return to main data display 

Click on the Data button to return to the RUNUP input table. 

If the RUNUP graphic is viewed again the graph will go back to showing the RUNUP 
input profile.  The Graph Results menu item needs to be selected again to view the 
results to the RUNUP model. 

11. Exiting RUNUP Program 

When the wave runup analysis is complete, close the RUNUP windows by clicking on 

the  X  in the upper right corners of each window. 

4.6 Program 6:  Summary Tables and Graphics for Mapping 

1. Summary Table 

This program is used to view all of the results from the analysis on the selected 

transect.  Click on the Summary Table button on the Main Menu Button Bar to 

open the window as shown below. 

 

Each phase or program of CHAMP is listed.  When a program has been completed, a 
check mark will be shown next to that program.  Should your modeling effort be 

If an area of shallow flooding exists beyond the crest of the dune and the 
runup overtops the crest of the dune, an area of shallow flooding should 
be identified by designating the area an AO Zone of 1, 2, or 3 foot depth.  
Consult the G&S for a more detailed explanation on the application of 
AO Zones. 



Coastal Hazard Analysis Modeling Program—User’s Manual 

CHAMP Version 2.0 August 2007  44 

interrupted for some reason, this feature can be used to keep track of all completed 
analyses and track the remaining analyses to be completed for each transect. 

To view the input and output and all of the results in tabular and text format, click on 
the Data Table drop-down menu.  Click on a table to view it.  The following tables are 
available for viewing: 

• Transect 

• Adjusted Transect 

• Eroded Transect 

• WHAFIS 

• WHAFIS Parts 1, 2, 3, 4, 5, and 6 

• STILLWATER 

• WHAFIS Input File 

• WHAFIS Output File 

• RUNUP 

• RUNUP Output 

• RUNUP Input File 

• RUNUP Output File 

• RUNUP Zone 

 

 

 

 

 

 

 

 

 

 

 

 

 



Coastal Hazard Analysis Modeling Program—User’s Manual 

CHAMP Version 2.0 August 2007  45 

 

2. Summary Graphics 

To view all of the analyses results in graphical format, click on the Graphics button 

on the Main Menu Button Bar.  The window below will open. 

 

This plot displays all of the results from each program within CHAMP.  Each feature 
can be turned off or on by selecting the Layers item under the Format menu.  The 
graphic can be printed by clicking on the Print menu item under the File menu. 

Two options available in the summary graphic important to displaying the results are 
drawing the PFD Limits and the Legend.  Both features can be drawn by selecting the 
commands from the Draw menu. 



Coastal Hazard Analysis Modeling Program—User’s Manual 

CHAMP Version 2.0 August 2007  46 

By selecting the draw PFD Limits item a horizontal zone bar is draw representing the 
minimum landward extent of the V-Zone.  The PFD has to be identified in the Edit 
Transect module before the PFD limit can be drawn. 

Selecting the Legend item in the Draw menu draws the legend on the right side of the 
grid.  The features in the legend will match the features that are turned on in the 
layers.  If layers are turned on or off or colors and line types are changed, the legend 
needs to be redrawn so that the changes are represented.  Selecting the Legend menu 
item again redraws the legend.  The legend can be moved as one piece anywhere 
desired by using the Move item under the Modify menu. 

From the Summary program, the results can be evaluated, and if one of the analysis 
programs needs to be revised or re-run, it can be accomplished by selecting the 
appropriate program and repeating the steps described above. 

When satisfied with the final results for a transect, the process is repeated for the 
next transect until the total project is complete. 

4.7 Graphic Controls 

The graphics are CADD like in function, and many of the commands work in the same 
way. The graphics for CHAMP are stored in one file for each transect with a DXF 
extension.  Each time a graphic is displayed and results are generated, the 
information is saved in the one DXF file for that transect.  Four options available to all 
graphic displays are Setup, View, Layers, and Print. 

1. Setup 

Under the Graph menu, click the Setup item to bring up the following window.  On 
the Summary Graphic, Setup is located under the View menu. 

 

This window is used to set the scale and grid for the graphical display.  The Y Scale 
field is used to stretch or shrink the vertical Y axis.  The Xmax and Xmin fields set the 
maximum and minimum stations of the grid.  The Ymax and Ymin fields set the 
maximum and minimum elevations of the grid.  The X Interval and Y interval fields set 
the intervals that the grid lines are displayed. 
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2. View 

To access the View menu either right click or select the View item under the Graph 
menu.  On the Summary Graphic, the View menu has more options than other 
graphs.  There are five zoom commands available. 

Zoom Window:  This option lets the user draw a box around an area to be 
zoomed in upon. 

 Zoom In:  Zooms one interval closer to center. 

 Zoom Out:  Zooms out one interval further from center. 

 Full Extent:  Fits all within screen window. 

Pan:  Lets the user drag the screen to re-center the view.  Panning can also be 
accomplished by using the horizontal and vertical slide bars. 

3. Layers 

Layers are used to turn on or off different features to be displayed on the graph.  Line 
types and colors of features can also be changed here.  The names of the layers 
correspond to a particular feature; for instance, SWEL100 corresponds to the 1% 
annual chance SWEL line.  The Layers window is accessed by clicking the Layers item 
under the Graph menu.  In the Summary Graphic, Layers is located under the 
Format menu. 

To turn a feature off, select the feature and click the Freeze button.  The feature must 

not be the current layer; otherwise, the layer will not Freeze.  To change the current 

layer, select a layer and click the Current button.  To turn a feature on, select the 

feature and click the Thaw button.  To change the color of a feature, click the COLOR 

button and a window will be displayed with the color options.  To change the line 

type, click the Ltype button and a list of available line types will be displayed. 

Below is an example of what the layer window looks like.  All of the possible layers 
that can be created are also listed here. 

 

 

 

 

 

Note:  The graphics have to be created first before the layers are created.  
Going through each program and viewing the graphs or graph results 
creates the layers.  Example:  The PEAK layer will not be created until 
the peak is selected in the Erosion program and the ERODED_LN layer 
will not be created until the erosion analysis is completed.  
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4. Print 

The Print command can be found under the File menu for all graphs.  Once selected, 
a window, as shown below, will appear. 
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From here, the printing options can be set.  For the best print follow the steps below: 

a. Select the print area by clicking on the Pick button and then drawing a box 

around the area to be printed. 

 b. Select Scale to Fit. 

c. Select the Select Printer button to setup the printer.  In the print window, 

select properties, where the user can change the paper size and orientation.  

The Orientation option on the Print window is not operational for Version 1.0 of 
CHAMP.  For best results, it is suggested that the orientation be landscape and 
the paper size “11 X 17” if available. 

d. Select the Update View button to update the print preview with the new 

settings to make sure the plot looks as desired. 

e. Select the Print button to send the plot to the printer. 

5. Summary Graphic Options 

There are more drawing and editing options available in the Summary Graphic 
program than for graphics associated with the other programs.  These options 
include: 

• Draw menu:  There are several items available under the draw menu to add 
lines and text to the graphic.  One can also draw a leader line, which is an 
arrow pointer.  The options to draw the PFD Limits and Legend are also here, 
as discussed earlier.  All new drawn objects will be placed into a layer called 
“Others.” 

• Format menu:  Here the user can change the layer options, text style, active 
properties, and the properties of any selected object. 
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• Modify menu:  Options to delete, move, and edit text can be found here.  To 
delete objects, first select the object and then click on the Delete item in the 
Modify menu.  The Delete key on the keyboard can also be used instead of 
using the menu item. 

To move an object, first click on the Move item in the Modify menu and then 
left click to select the objects to be moved; next right click to finish selecting 
objects and then select the base point to move the objects by left clicking on 
the base point.  Finally drag the object to the desired location and left click to 
move the object. 

To edit text select the Text item under the Modify menu and then select the text 
to be modified.  Here the user can change the text size and justification as well 
as edit the text. 

Any changes or modification to the graphic can be undone by selecting the Undo item 
under the Edit menu.  A change or modification can be brought back after undoing by 
selecting the Redo item under the Edit menu. 

4.8 Help Menu 

The help menu is located on the main window.  Three electronic documents available 
for assistance with CHAMP include this user’s manual, the G&S, and a WHAFIS 4.0 
help document.  All documents are in .pdf format.  Adobe Acrobat Reader must be 
installed to view these documents. 


